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Kit Contents

Investigator HDplex Kit (25) (100)
Catalog no. 381213 381215
Number of 25 pl reactions 25 100
Reaction Mix A 125 ul 500 ul
Primer Mix HDplex 63 ul 250 ul
Multi Tag2 DNA Polymerase 25U 100 U
Control DNA 9948 200 ul 200 ul
DNA Size Standard 550 (BTO) 13 pl 50 ul
Allelic Ladder HDplex 25 ul 25 ul
Nuclease-Free Water 1.9 ml 2x1.9ml
Quick-Start Protocol 1 1
Storage

All components of the Investigator HDplex Kit should be stored at —20°C. Avoid
repeated freezing and thawing. Primer mix and allelic ladder must be stored
protected from light. DNA samples and post-PCR reagents (allelic ladder and
DNA size standard) should be stored separately from the PCR reagents. Under
these conditions, the components are stable until the expiration date indicated
on the kit.

Intended Use

The Investigator HDplex Kit is intended for molecular biology applications in
forensic, human identity, and paternity testing. This product is not intended for
the diagnosis, prevention, or treatment of a disease.

All due care and attention should be exercised in the handling of the products.
We recommend all users of QIAGEN products to adhere to the NIH guidelines
that have been developed for recombinant DNA experiments, or to other
applicable guidelines.
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Safety Information

When working with chemicals, always wear a suitable lab coat, disposable
gloves, and protective goggles. For more information, please consult the
appropriate material safety data sheets (SDSs). These are available online in
convenient and compact PDF format at www.giagen.com/safety where you can
find, view, and print the SDS for each QIAGEN kit and kit component.

24-hour emergency information

Emergency medical information in English, French, and German can be
obtained 24 hours a day from:

Poison Information Center Mainz, Germany
Tel: +49-6131-19240

I EEEE————————————————————————
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Introduction

The Investigator HDplex Kit is a multiplex application for specific forensic
applications and paternity testing. The 12 highly discriminative short tandem
repeat (STR) loci allow a reliable differentiation of forensic samples derived from
related individuals. The Investigator HDplex Kit enables fast and reliable
generation of DNA profiles from blood, buccal swabs, and forensic stains.

In one PCR reaction, D2S1360, D3S1744, D4S2366, D5S52500, D6S474,
D7S1517, D8S1132, D10S2325, D12S391, D18S51, D21S2055, and SE33
[ACTBP2]), and the gender-specific Amelogenin are amplified simultaneously.

The primers are fluorescence-labeled with one of the following dyes:

B 6-FAM™: Amelogenin, D7S1517, D3S1744, D12S391, D2S1360,
D65S474, D4S2366

B BTG: D8S1132, D552500, D18S51, D21S2055
B BTY: D10S2325, SE33.

The optimal amount of DNA under standard conditions is 0.2-1.0 ng. Internal
validations demonstrated reliable results with <0.1 ng DNA.

The Investigator HDplex Kit has been validated using the GeneAmp® PCR
System 9700, ABI PRISM® 310, ABI PRISM 3100, and Applied Biosystems®
3130 Genetic Analyzers.

Table T and Table 2 show the STR loci with their chromosomal mapping, repeat
motifs, and alleles that are concordant with the International Society for
Forensic Genetics (ISFG) guidelines for the use of microsatellite markers (Bér et
al., 1997). Allele ranges include all known alleles of the National Institute of
Standards and Technology (NIST as of 05/2010) and the current literature.

I EEEE————————————————————————
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Table 1. Locus-specific information for the Investigator HDplex Kit

GenBank®
accession Repeat motif of the Reference Allele
Locus number reference allele allele range
Amelogenin X M55418 — - —
Amelogenin Y M55419 — — -
[TATC], [TGTC]y
D2S51360 G08130 [TATC. 23 19-32
[TCTA], TA[TCTA],,
D3S1744 G08246 TCA [TCTAJ, 16 13-22
D4S2366  G08339 [ATAG], ATTG [ATAG], 12 9-15
D5S2500 G08468 [ATAG],, 12 9-18
D6S474 G08540 [TAGA]; TGA [TAGA];, 17 11-20
[GAAA],, CAAA
D7S1517 G18365 [GAAA], CAAA 17 14-31
[GAAA],
[TCTA], TCA [TCTA],
D8S1132 G08685 TCTGTCTA 20 12.1-27
D10S2325  G08790 [TCTTA];, 12 6-23
[AGAT]; GAT [AGAT],
D12S391 G08921 [AGAC], AGAT 19.3 13-28
D18S51 L18333 [AGAA]13 13 5.3-42
D21S2055  G27274 [CTAT], CTAA [CTAT], 24 16.1-39
CTA [CTAT], TAT
[CTAT]; TAT [CTAT],
CAT[CTAT],
HediE NG000840  [AAAG], AA [AAAG] 252  3-50
(ACTBP2) ? 16 ‘
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Table 2. Chromosomal mapping of Investigator HDplex Kit

Locus Chromosomal mapping
Amelogenin X Xp22.1-22.3
Amelogenin Y Yp11.2
D2S1360 2p24-p22
D3S1744 3p24
D4S2366 4p16-15.2
D5S2500 5q11.2
D6S474 6921-22
D751517 7931.33
D8S1132 89g23.1
D10S2325 10p12
D12S391 12p13.2
D18S51 18921.3
D2152055 21922
SE33 6q14.2

I EEEE————————————————————————
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Equipment and Reagents to Be Supplied by User

When working with chemicals, always wear a suitable lab coat, disposable
gloves, and protective goggles. For more information, consult the appropriate
material safety data sheets (MSDSs), available from the product supplier.

B  Hi-Di™ Formamide, 25 ml (Applied Biosystems, cat. no. 4311320)

B Matrix Standards BT5 for single-capillary instruments, e.g., ABI PRISM 310
Genetic Analyzer (QIAGEN, cat. no. 386113)

B Matrix Standards BT5 for multi-capillary instruments, e.g., ABI PRISM 3100
and Applied Biosystems 3130 and 3500™ Genetic Analyzers (QIAGEN,
cat. nos. 386123 or 386125)

B Pipets and pipet tips

B One of the following DNA analyzers:
ABI PRISM 310 Genetic Analyzer
ABI PRISM 3100-Avant™ /3100 Genetic Analyzer
Applied Biosystems 3130/3130x/ Genetic Analyzer
Applied Biosystems 3500/3500xL Genetic Analyzer

M One of the following PCR thermal cyclers:
GeneAmp PCR System 9700
Bio-Rad PTC-200
Techne TC-512
Biometra T1
Eppendorf® Mastercycler® ep

B PCR tubes or plates

Validity analysis software for human identification products

Investigator Human Identification PCR Kits require calibration with an allelic
ladder. Therefore, the software used must be compatible with human identification
(HID) products for forensic applications. We recommend Investigator IDproof,
Investigator IDproof Mixture, GeneMapper® ID, GeneMapper ID-X, or Genotyper®
Software. The Investigator Template Files facilitate data analysis and are valid with
the software mentioned above.
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Protocol: PCR Amplification

This protocol is for PCR amplification of STR loci from forensic samples using
the Investigator HDplex Kit.

Important points before starting

B Set up all reaction mixtures in an area separate from that used for DNA
isolation and PCR product analysis (post-PCR).

B Use disposable tips containing hydrophobic filters to minimize cross-
contamination.

Things to do before starting

B Before opening the tubes with PCR components, vortex and then centrifuge
briefly to collect contents at the bottom of the tubes.

Procedure

1. Thaw PCR components and template nucleic acid.
Mix thoroughly before use.

2. Prepare a master mix according to Table 3.
The master mix contains all of the components needed for PCR except the
template (sample) DNA and nuclease-free water.

Prepare a volume of master mix 10% greater than that required for the total
number of PCR assays to be performed. This should include positive and
negative control reactions.

3. Mix the master mix thoroughly, and dispense appropriate volumes
into PCR tubes or the wells of a PCR plate.

4. Add template DNA and nuclease-free water to the master mix, to
give a final sample volume of 25 pl.

5. Prepare positive and negative controls.
Positive control: Use 5 ul of the Control DNA.

Negative control: Use nuclease-free water instead of template DNA in the
reaction.
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Table 3. Reaction setup

Component Volume per reaction
Reaction Mix A* 5.0 ul

Primer Mix 2.5 ul

Multi Tag2 DNA Polymerase 0.4 ul
Nuclease-free water (added in step 4) Variable
Template DNA (added in step 4) Variable

Total volume 25 ul

* Contains dNTP mix, MgCl,, and bovine serum albumin (BSA).

6. Program the thermal cycler according to the manufacturer’s
instructions, using the conditions outlined in Table 4.
For stains containing small amounts of DNA (<100 pg/25 ul reaction), we
recommend using the cycling conditions outlined in Table 5.

Note: If using the GeneAmp PCR System 9700 with an Aluminum Block,
use “Std Mode”, or with a Silver 96-Well Block or Gold-plated Silver
96-Well Block, use “9600 Emulation Mode”. Do not use “Max Mode”.

Table 4. Standard cycling protocol, recommended for all DNA samples

Temperature Time Number of cycles
Q4°C* 4 min -~

94°C 30s

60°C 120's 30 cycles

72°C 75s

68°C 60 min -

10°C 00 -

* Hot-start to activate DNA polymerase.
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Table 5. Optional cycling protocol, recommended for stains containing
small amounts (<100 pg) of DNA

Temperature Time Number of cycles
94°C* 4 min -

94°C 30s

60°C 120s 32 cycles

72°C 75s

68°C 60 min -

10°C o0 -

* Hot-start to activate DNA polymerase.

7. After the cycling protocol is completed, store samples at —20°C
protected from the light, or proceed directly with running the
electrophoresis.

12 Investigator HDplex Handbook 11/2012



Protocol: Electrophoresis Using the ABI PRISM 310
Genetic Analyzer

For general instructions on instrument setup, matrix generation, and application
of the GeneScan® or GeneMapper ID Software, refer to the ABI PRISM 310
Genetic Analyzer User’s Manual. Electrophoresis using the GeneScan Software
is described below.

The virtual filter set G5 is used for combined application of the 5 fluorescent
labels 6-FAM, BTG, BTY, BTR, and BTO. This matrix standard is known as BT5.

The materials required for electrophoresis are given in Table 6.

Table 6. Materials required for electrophoresis

Material Specifications

Capillary 47 cm/50 um (green)

Polymer POP-4™ for ABI PRISM 310 Genetic Analyzer
Buffer 10x Genetic Analyzer Buffer with EDTA

Matrix generation

Before conducting DNA fragment size analysis with the filter set G5, a matrix
with the 5 fluorescent labels 6-FAM, BTG, BTY, BTR, and BTO must be

generated (Table 7).

Table 7. The 5 fluorescent labels of BT5

Color Matrix standard
Blue (B) 6-FAM

Green (G) BTG

Yellow (Y) BTY

Red (R) BTR

Orange (O) BTO
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1. Five electrophoresis runs should be conducted, one for each
fluorescent label, under the same conditions as for the samples and
allelic ladders of the Investigator HDplex Kit, in order to generate
suitable matrix files (Table 8).

Table 8. Matrix setup for single capillary instruments (ABI PRISM 310
Genetic Analyzer)

Matrix sample Component Volume
Matrix sample 1 Hi-Di Formamide 12.0 ul
Matrix standard 6-FAM 1.0 ul
Matrix sample 2 Hi-Di Formamide 12.0 ul
Matrix standard BTG 1.0 ul
Matrix sample 3 Hi-Di Formamide 12.0 ul
Matrix standard BTY 1.0 ul
Matrix sample 4 Hi-Di Formamide 12.0 ul
Matrix standard BTR 1.0 ul
Matrix sample 5 Hi-Di Formamide 12.0 ul
Matrix standard BTO 1.0 ul

2. Denature for 3 min at 95°C.
3. Snap freeze by placing the plate on ice for 3 min.
Alternatively, the thermal cycler set to 4°C may be used to cool the plate.

4. Load the samples on the tray.

5. Create a Sample Sheet and enter the sample designation. Table 9
shows the injection list for matrix generation.

I EEEE————————————————————————
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Table 9. Injection list for matrix generation

Parameter Settings

Module File GS STR POP-4 (1 ml) G5
Matrix File None

Size Standard None*

Injection Time (s) 5

Injection Voltage (kV) 15

Run Voltage (kV) 15

Run Temperature (°C) 60

Run Time (min) 24

* Always prepare matrix standards without DNA Size Standard (BTO).

Analysis of the matrix samples

Run the GeneScan Software.

Select “New” from the File menu, and then select “Project”.
Open the folder of the current run and select “Add Sample Files”.
Select a matrix sample in the “Sample File” column.

Click “Sample” and then “Raw Data”.

Check the matrix samples for a flat baseline. As shown in the figure
(next page), there should be at least 5 peaks with peak heights of
1000-4000 RFU for each matrix sample.

Note: The optimal range is 2000-4000 RFU.

Al L S
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Electropherogram with raw data of the matrix standard 6-FAM.

7. Select an analysis range with a flat baseline and re-inject the matrix
sample, if necessary.

8. Record start and end value (data points) of the analysis range; e.g.,
start value 3200, end value 5500.

9. Calculate the difference between the end and start values; e.g.,
5500-3200=2300 data points.

Generation of a matrix

1. Select “New” in the File menu, and then select “Matrix”.
Import the matrix samples for all dyes (B, G, Y, R, and O).
Enter a “Start At” value, e.g., 3200.

Under “Points”, enter the calculated difference between end and
start values, e.g., 2300.

WN

5. Click “OK"” to calculate the new matrix.

WlE Make New Matrix

Select the Matix Standard Sample Files Mumber OF Dyes:

A (el

B EFAM_080204.fsa Start A 200

BTG_080204 fsa Start At: 3000

|

|

BTR_080204 fsa Start A 3000

|

G
hs BTY_0280204.fsa Start At: oo
R
0
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Points: 2300

|

f=1
=

Cancel

Matrix sample selection.

16 Investigator HDplex Handbook 11/2012



6. Select “Save as” in the File menu to save the new matrix in the

matrix folder.
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New matrix BT5.

Checking the matrix

1. To check the new matrix with current samples, select “New” in the
File menu, and then select “Project”.

2. Open the folder of the respective run and select “Add Sample Files”.

@

Select the sample(s) in the Sample File column.

4. Click “Sample” and then “Install New Matrix” to open the matrix
folder and select the new matrix.

5. Re-analyze the samples.

Note: There should be no pull-up peaks between the dye panels (B, G, Y,

R, O) with the new matrix.

Sample preparation

1. Set up a mixture of formamide and DNA size standard according to

Table 10.

Table 10. Setup of formamide and DNA size standard mixture

Component

Volume per sample

Hi-Di Formamide

DNA Size Standard 550 (BTO)

12.0 ul
0.5 ul

2. Aliquot 12 ul of the mixture to a tube for each sample to be

analyzed.
Add 1 pl PCR product or allelic ladder (diluted, if necessary).

w

4. Denature for 3 min at 95°C.

Investigator HDplex Handbook
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5. Snap freeze by placing the plate on ice for 3 min.
Alternatively, the thermal cycler set to 4°C may be used to cool the plate.

6. Load the samples on the tray.

Setting up the GeneScan Software

Create a Sample Sheet and enter sample designation.

Table 11. Injection list for the ABI PRISM 310 Genetic Analyzer

Component Settings

Module File GS STR POP-4 (1 ml) G5
Matrix File e.g., Matrix BT5

Size Standard e.g., SST-BTO_60-500bp
Injection Time (s) 5*

Injection Voltage (kV) 15

Run Voltage (kV) 15

Run Temperature (°C) 60

Run Time (min) 28f

* Deviating from standard settings, the injection time may range between 1 and 10 s
depending on the type of sample. If samples with very high signal intensities are recorded, a
shorter injection time may be selected. For samples with low DNA content, an injection time
up to 10 s may be necessary.

t The run time for Investigator HDplex was modified in order to be able to analyze fragments
with lengths of up to 500 bp.
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Analysis parameters

Table 12 lists the recommended analysis parameters.

Table 12. Recommended analysis parameters for the ABI PRISM 310
Genetic Analyzer

Parameter Settings
Analysis Range Start: 2000
Stop: 10,000

Data Processing Baseline: Checked
Multi-component: Checked
Smooth options: Light

Peak Detection Peak Amplitude Thresholds
B:* Y:*
G:* R:*
O:*
Min. Peak Half Width: 2 pts
Polynomial Degree: 3
Peak Window Size: 11 pts'

Size Call Range Min: 60

Max: 550
Size Calling Method Local Southern Method
Split Peak Correction None

* The peak amplitude threshold (cutoff value) corresponds to the minimum peak height that will be
detected by the GeneScan or GeneMapper ID Software. Thresholds are usually 50-200 RFU and
should be determined individually by the laboratory. Recommendation: The minimal peak height
should be three-times as high as the background noise of the baseline.

t Only the setting for Peak Window Size is different to defaults from Applied Biosystems for
HID analysis.

Note: For information on the use of the recommended Template Files (as
analysis parameters), refer to the appropriate Investigator Template Files User
Guide (Genotyper, GeneMapper ID, or GeneMapper ID-X).
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Protocol: Electrophoresis Using the ABI PRISM 3100-
Avant/3100 Genetic Analyzer

For detailed instructions on instrument setup, spectral calibration, application of
the ABI PRISM 3100 Data Collection Software version 1.01 or 1.1 and the

GeneScan Software, refer to the ABI PRISM 3100-Avant/3100 Genetic Analyzer
User’s Manual.

The system with 4 capillaries is the ABI PRISM 3100-Avant Genetic Analyzer,
and the system with 16 capillaries is the ABI PRISM 3100 Genetic Analyzer.

The virtual filter set G5 is used for combined application of the 5 fluorescent
labels 6-FAM, BTG, BTY, BTR, and BTO. This matrix standard is known as BT5.

The materials required for electrophoresis are given in Table 13.

Table 13. Materials required for electrophoresis

Material Specifications

Capillary 36 cm Capillary Array for ABI PRISM 3100-Avant/3100
Genetic Analyzer

Polymer POP-4 Polymer for ABI PRISM 3100-Avant/3100
Genetic Analyzer
Buffer 10x Genetic Analyzer Buffer with EDTA

Spectral calibration/matrix generation

Proper spectral calibration is critical for evaluation of multicolor systems with the
ABI PRISM 3100-Avant/3100 Genetic Analyzer and should be done before
conducting fragment length analysis. The calibration procedure creates a matrix
which is used to correct the overlapping of fluorescence emission spectra of the
dyes.

Spectral calibration comprises the following steps:
B Preparing the spectral calibration standards

B Loading the standards to the 96-well reaction plate (one sample per
capillary)

B Entering the plate composition

B Performing a spectral calibration run and checking the matrix
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Preparing the spectral calibration standards

Example for 4 capillaries (ABI PRISM 3100-Avant Genetic Analyzer)

1. Set up a mixture of formamide and Matrix Standard BT5 according to
Table 14.

Table 14. Setup of formamide and Matrix Standard BT5 mixture for 4
capillaries

Component Volume
Hi-Di Formamide 60 ul
Matrix Standard BT5 multi cap. 5 ul

2. Load 12 pl of the mixture to 96-well plate; e.g., position A1-D1.
Denature for 3 min at 95°C.

w

4. Snap freeze by placing the plate on ice for 3 min.
Alternatively, the thermal cycler set to 4°C may be used to cool the plate.

Example for 16 capillaries (ABI PRISM 3100 Genetic Analyzer)

1. Set up a mixture of formamide and Matrix Standard BT5 according to
Table 15.

Table 15. Setup of formamide and Matrix Standard BT5 mixture for
16 capillaries

Component Volume
Hi-Di Formamide 204 ul
Matrix Standard BT5 multi cap. 17 ul

2. Load 12 ul of the mixture to 96-well plate; e.g., position A1-H1 and
A2-H2.

Denature for 3 min at 95°C.
4. Snap freeze by placing the plate on ice for 3 min.
Alternatively, the thermal cycler set to 4°C may be used to cool the plate.

@
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Performing a spectral calibration run

The parameter file for DyeSetG5 must be modified once to achieve successful
calibration with the Data Collection Software version 1.0.1 or 1.1.

Spectral parameter

1.

!*’

To change settings in the parameter file, go to the following path:

D:\AppliedBio\Support Files\Data Collection
SupportFiles\CalibrationData\Spectral Calibration\ParamFiles

Select “MixSTD{Genescan_SetG5} to open the PAR file.
Change “Condition Bounds Range” to [1.0; 20.0].

If the calibration was unsuccessful, also change Sensitivity to 0.1 and
Quality to 0.8.

Select “Save As” in the File menu and save the parameter file with a
new name; e.g., MixStd{Genescan_SetG5_BT5}.par.

Note: Always use this parameter file for spectral calibration runs using
QIAGEN Matrix Standard BT5.

Plate Editor for spectral calibration

oAb

Place the 96-well plate on the autosampler tray.

Run the ABI PRISM 3100 Data Collection Software.

In Plate View, click “New” to open the Plate Editor dialog box.
Enter a name for the plate.

Select a Spectral Calibration.

Select “96-Well” as plate type, and click “Finish”.

Table 16. Plate Editor for spectral calibration

Parameter Settings

Sample Name Enter name for the matrix samples

Dye Set G5

Spectral Run Module Default (e.g., Spect36_POP4)

Spectral Parameters MixStd{GeneScan_SetG5 BT5}.par
(parameters created before)

7.

22

Click the column header to select the entire column, and select “Fill
Down” from the Edit menu to apply the information to the selected
samples. Confirm by clicking “OK".
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8. Link the reaction plate on the autosampler tray with the created
plate ID and start the run.

9. Upon completion of the run, check in the Spectral Calibration Result
dialog box that all capillaries have successfully passed calibration
(label A).

If individual capillaries are labeled X, refer to the ABI PRISM 3100-
Avant/3100 Genetic Analyzer User’s Manual.

10. Click “OK"” to confirm completion of the run.

Checking the matrix

1. Select “Display Spectral Calibration” from the Tools menu, then “Dye
Set” and “G5” to review the spectral calibration profile for each
capillary.

2. The quality value (Q value) must be greater than 0.95 and the
condition number (C value) must be between 1 and 20. Both values
must be within the pre-determined range.

3. Check for a flat baseline in the matrix samples. There should be 5
peaks with heights of 1000-5000 RFU in each matrix sample.

Note: The optimal range is 2000-4000 RFU.
4. Check the new matrix with the current samples. There should be no

pull-up peaks between the dye panels (B, G, Y, R, and O) with the
new matrix.

5. If the calibration failed, follow the section “Spectral parameter” on
page 22.

6. If all capillaries have passed the calibration, the last calibration file
for Dye Set G5 must be activated manually. Click “Set Active Spectral
Calibration” under the Tools menu.

7. Rename the calibration file under Set Matrix Name (e.g., BT5_Date of
calibration).

Sample preparation

1. Set up a mixture of formamide and DNA size standard according to
Table 17.

Table 17. Setup of formamide and DNA size standard mixture

Component Volume per sample
Hi-Di Formamide 12 ul
DNA Size Standard 550 (BTO) 0.5 ul
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2. Aliquot 12 ul of the mixture to a tube for each sample to be
analyzed.

Add 1 ul PCR product or allelic ladder (diluted, if necessary).
Denature for 3 min at 95°C.

P w

5. Snap freeze by placing the plate on ice for 3 min.
Alternatively, the thermal cycler set to 4°C may be used to cool the plate.

6. Load the samples on the tray.

Since injections take place simultaneously on all capillaries, 4 or 16 samples
must be pipetted onto the plate of multi-capillary analyzers. If fewer samples
are analyzed, the empty positions must be filled with 12 ul Hi-Di Formamide.

To ensure a reliable allelic assignment on multi-capillary analyzers, several
ladders should be run.

Room temperature may influence the performance of PCR products on multi-
capillary instruments, so that shoulder peaks or split peaks occur especially at
low temperatures. Ensure ambient conditions are kept as recommended by the
instrument manufacturer.

Setting up the GeneScan Software
1. Edit the default run module in Dye Set G5 once for the first run.
Select “Module Editor” to open the dialog box.

2. Select the appropriate Run Module as template from the GeneScan
table (see Table 18).

Modify the Injection Voltage to 3 kV and the Injection Time to 10 s.

4. Click “Save As” and enter the name of the new module (e.g.,
3kV_10s_500bp). Confirm by clicking “OK".

5. Click “Close” to exit the Run Module Editor.

w
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Table 18. Run Module 3kV_10s_500bp for the ABI PRISM 3100-

Avant/3100 Genetic Analyzer

Parameter Setting
Run Temperature (°C) Default
Cap Fill Volume Default
Maximum Current (A) Default
Current Tolerance (A) Default
Run Current (A) Default
Voltage Tolerance (kV) Default
Pre-Run Voltage (kV) Default
Pre-Run Time (s) Default
Injection Voltage (kV) 3.0

Injection Time (s) 10*

Run Voltage (kV) Default
Number of Steps Default
Voltage Step Interval Default
Data Delay Time (s) Default
Run Time (min) 261

* Deviating from the standard settings, the injection time may range between 1 and 20 s

depending on the type of sample. If samples with very high signal intensities are recorded, a
shorter injection time may be selected. For samples with low DNA content, an injection time
of up to 20 s may be necessary.

* The run time for Investigator HDplex was modified in order to be able to analyze fragments

with lengths of up to 500 bp.

Starting the run

counhwbh=

Investigator HDplex Handbook
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Place the prepared 96-well plate on the autosampler tray.
Run the ABI PRISM 3100 Data Collection Software.

In Plate View, click “New” to open the Plate Editor dialog box.
Enter a name for the plate.
Select “GeneScan” as the application type.

Select “96-Well” as plate type, and click “Finish”.
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Table 19. Settings in Plate Editor

Parameter Settings

Sample Name Enter name for the matrix samples
Dyes @)

Color Info Ladder or sample

Project Name e.g., 3100 _Project]

Dye Set G5

Run Module 3kV_10s 500bp*

Analysis Module 1 DefaultAnalysis.gsp

* See Table 18, “Run Module 3kV_10s_500bp for the ABI PRSIM 3100-Avant/3100 Genetic
Analyzer”.

7. Complete the table in the Plate Editor and click “OK".

8. Click the column header to highlight the entire column and select
“Fill Down"” from the Edit menu to apply the information to the
selected samples.

9. Link the reaction plate on the autosampler tray to the created plate
ID and start the run.

10. When the run is complete, view the data as Color Data in the Array

View of the 3100 Data Collection Software or as Analyzed Sample
Files under D:/AppliedBio/3100/DataExtractor/ExtractRuns.
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Analysis parameters

Table 20 lists the recommended analysis parameters.

Table 20. Recommended analysis parameters for the ABI PRISM 3100-
Avant/3100 Genetic Analyzer

Parameter Settings
Analysis Range Start: 2000

Stop: 10,000
Data Processing Baseline: Checked

Multi-component: Checked
Smooth options: Light

Peak Detection Peak Amplitude Thresholds
B:* Y:*
G:* R:*
O:*
Min. Peak Half Width: 2 pts
Polynomial Degree: 3
Peak Window Size: 11 pts'

Size Call Range Min: 60

Max: 550
Size Calling Method Local Southern Method
Split Peak Correction None

* The peak amplitude threshold (cutoff value) corresponds to the minimum peak height that will be
detected by the GeneScan or GeneMapper ID Software. Thresholds are usually 50-200 RFU and
should be determined individually by the laboratory. Recommendation: The minimal peak height
should be three-times higher than the background noise of the baseline.

t Only the setting for Peak Window Size is different to defaults from Applied Biosystems for
HID analysis.

Note: For information on the use of the recommended Template Files (as
analysis parameters), refer to the appropriate Investigator Template Files User
Guide (Genotyper, GeneMapper ID, or GeneMapper ID-X).

Investigator HDplex Handbook 11/2012 27



Protocol: Electrophoresis Using the Applied
Biosystems 3130/3130xI Genetic Analyzer

For detailed instructions on instrument setup, spectral calibration, or application
of the ABI PRISM Data Collection Software version 3.0 and the GeneMapper ID
Software, refer to the Applied Biosystems 3130/3130x| Genetic Analyzers
Getting Started Guide.

The system with 4 capillaries is the Applied Biosystems 3130 Genetic Analyzer,
and the system with 16 capillaries is the Applied Biosystems 3130x/ Genetic
Analyzer.

The virtual filter set Any5Dye is used for combined application of the 5
fluorescent labels 6-FAM, BTG, BTY, BTR, and BTO. This matrix standard is
known as BT5.

The materials required for electrophoresis are given in Table 21.

Table 21. Materials needed for electrophoresis

Material Specifications

Capillary 36 cm Capillary Array for Applied Biosystems
3130/3130xI Genetic Analyzer

Polymer POP-4 Polymer for Applied Biosystems 3130/3130x/
Genetic Analyzer
Buffer 10x Genetic Analyzer Buffer with EDTA

Spectral calibration/matrix generation

Before conducting DNA fragment size analysis, it is necessary to perform a
spectral calibration with the 5 fluorescent labels 6-FAM, BTG, BTY, BTR, and
BTO for each analyzer. The calibration procedure creates a matrix which is
used to correct the overlapping of fluorescence emission spectra of the dyes.

Spectral calibration is comprised of the following steps:
B Preparing the spectral calibration standards

B Loading the standards to the 96-well reaction plate (one sample per
capillary)

B Creating the instrument protocol for spectral calibration (Protocol Manager)
B Defining the plate composition in the plate editor (Plate Manager)

B Performing a spectral calibration run and checking the matrix

28 Investigator HDplex Handbook 11/2012



Preparing the spectral calibration standards

Example for 4 capillaries (Applied Biosystems 3130 Genetic Analyzer)

1. Set up a mixture of formamide and Matrix Standard BT5 according to
Table 22.

Table 22. Setup of formamide and Matrix Standard BT5 mixture for
4 capillaries

Component Volume
Hi-Di Formamide 60 ul
Matrix Standard BT5 multi cap. 5ul

2. Load 12 ul of the mixture to 96-well plate, e.g., positions A1-D1.
Denature for 3 min at 95°C.

w

4. Snap freeze by placing the plate on ice for 3 min.
Alternatively, the thermal cycler set to 4°C may be used to cool the plate.

Example for 16 capillaries (Applied Biosystems 3130xI Genetic Analyzer)

1. Set up a mixture of formamide and Matrix Standard BT5 according to
Table 23.

Table 23. Setup of formamide and Matrix Standard BT5 mixture for
16 capillaries

Component Volume
Hi-Di Formamide 204 ul
Matrix Standard BT5 multi cap. 17 ul

2. Load 12 ul of the mixture to 96-well plate, e.g., position A1-H1 and
A2-H2.

Denature for 3 min at 95°C.

w

4. Snap freeze by placing the plate on ice for 3 min.
Alternatively, the thermal cycler set to 4°C may be used to cool the plate.
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Performing spectral calibration run

1. Place the 96-well plate on the autosampler tray.
2. In the Protocol Manager of the Data Collection Software, open the

Instrument Protocol window.

3. Click “New” to open the Protocol Editor dialog box.

4. Complete the dialog box with the information in Table 24 and click

llo Kll.

Table 24. Instrument protocol for spectral calibration

Array Length
Chemistry
Run Module

Protocol Editor Settings

Name User (e.g., Spectral36 POP4 BT5)
Type SPECTRAL

Dye Set Any5Dye

Polymer User (e.g., POP4)*

User (e.g., 36cm)*
Matrix Standard
Default (e.g., Spect36 POP4 1)*

* Depends on the type of polymer and length of capillary used.

5. Click “New” in the Plate Manager of the Data Collection Software to

open the New Plate Dialog box.

6. Enter information from Table 25 and click “OK”. A new table in the
Plate Editor opens automatically (Table 26).

Table 25. Plate Editor for spectral calibration (I)

Owner Name/
Operator Name

New plate dialog Settings

Name e.g., Spectral BT5 date
Application Spectral Calibration
Plate Type 96-well
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Table 26. Plate Editor for spectral calibration ()

Parameter Settings
Sample Name Enter name for the matrix samples
Priority e.g., 100

Instrument Protocol 1T Spectral36 POP4 BT5 (setting described previously)

7. Click the column header to select the entire column, and select “Fill
Down” from the Edit menu to apply the information to the selected
samples. Confirm by clicking “OK".

8. Link the reaction plate on the autosampler tray with the created
plate ID (position A or B) and start the run.

G Instruments > 03130 > 3130-1 > Spectral Viewsr

3000

2000

1000

0

-1000
0 3000

Intensityvs Scan Number

Capillary Data: Mon Way 25 09:21:23 CEST 2008 ‘ o R v G B

AD1
Dye St ArysDye
Active Calibration for Dye Set: AnySDye
Matrisc uised for Capillary 4 4 Mon May 25 09:21:23 CEST 2009

Contion 6.937256

a vale 0875648 List of Calibrations for Dye Set: AnySDye
Mon May 25 09:21:23 CEST 2009

Electropherogram of spectral calibration with matrix standard BT5 on an Applied
Biosystems 3130 Genetic Analyzer.
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Checking the matrix

1. The quality value (Q value) of each capillary must be greater than
0.95 and the condition number range (C value) must be between 1
and 20.

2. Check for a flat baseline in the matrix samples. As shown in the
figure on the previous page, there should be 5 peaks with peak
heights of about 1000-5000 RFU in each matrix sample.

Note: The optimal range is 2000-4000 RFU.
3. Check the new matrix with the current samples. There should be no

pull-up peaks between the dye panels (B, G, Y, R, O) with the new
matrix.

4. If calibration failed, use the optimized values of the Matrix Standard
BT5 and repeat the calibration run.

5. If all capillaries have passed the test, the last calibration file for the
Dye Set Any5Dye is activated automatically in the Spectral Viewer.
Rename the calibration file (e.g., BT5_Date of calibration).

Sample preparation

1. Set up a mixture of formamide and DNA size standard according to
Table 27.

Table 27. Setup of formamide and DNA size standard mixture

Component Volume per sample
Hi-Di Formamide 12.0 ul
DNA Size Standard 550 (BTO) 0.5 ul

2. Aliquot 12 ul of the mixture to a tube for each sample to be
analyzed.

Add 1 pl PCR product or allelic ladder (diluted, if necessary).
Denature for 3 min at 95°C.

il o

5. Snap freeze by placing the plate on ice for 3 min.
Alternatively, the thermal cycler set to 4°C may be used to cool the plate.

6. Load the samples on the tray.
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Since injections take place simultaneously on all capillaries, 4 or 16 samples
must be pipetted onto the plate of multi-capillary analyzers. If fewer samples
are analyzed, the empty positions must be filled with 12 ul Hi-Di Formamide.

To ensure a reliable allelic assignment on multi-capillary analyzers, several
ladders should be run.

Room temperature may influence the performance of PCR products on multi-
capillary instruments, so that shoulder peaks or split peaks occur especially at
low temperatures. Ensure ambient conditions are kept, as recommended by the
instrument manufacturer.

Setting up the Data Collection Software

1. Edit the Run Module once for the first run. In the Module Manager of
the Data Collection Software, click “New” to open the Run Module
Editor dialog box.

Note: Modify the Run Module Default settings from
“HIDFragmentAnalysis36_POP4 1" to those shown in Table 28.

2. Modify the Injection Voltage to 3 kV and the Injection Time to 10 s
(Table 28).

3. Click “Save As”, enter a name for the new Run Module
(e.g., 3kV_10s_500bp), and confirm by clicking “OK".

4. Click “Close” to exit the Run Module Editor.
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Table 28. Run Module 3kV_10s_500bp for the Applied Biosystems
3130/3130xI Genetic Analyzer

Parameter Settings
Oven Temperature (°C) Default
Poly Fill Volume Default
Current Stability (uA) Default
Pre-Run Voltage (kV) Default
Pre-Run Time (s) Default
Injection Voltage (kV) 3.0
Injection Time (s) 10*
Voltage Number of Steps Default
Voltage Step Interval Default
Data Delay Time (s) Default
Run Voltage (kV) Default
Run Time (s) 1560t

* Deviating from the standard settings, the injection time may range between 1 and 20 s
depending on the type of sample. If samples with very high signal intensities are recorded, a
shorter injection time may be selected. For samples with low DNA content, an injection time
of up to 20 s may be necessary.

t The run time for Investigator HDplex was modified in order to be able to analyze fragments
with lengths of up to 500 bp.

Starting the run

1. Place the prepared 96-well plate on the autosampler tray.
2. Open the Protocol Manager of the Data Collection Software.

3. Click “New” in the Instrument Protocol window to open the Protocol
Editor dialog box and enter the information in Table 29.

4. Click “OK” to exit the Protocol Editor.
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Table 29. Settings in Instrument Protocol

Protocol Editor Settings

Name Run36_POP4 BT5 26min
Type REGULAR

Run Module 3kV_10s_500bp*

Dye Set Any5Dye

* See Table 28, “Run Module 3kV_10s_500bp for the Applied Biosystems 3130/3130x/
Genetic Analyzer”.

5. Before each run, it is necessary to create a plate definition. In the
Plate Manager of the Data Collection Software, click “New” to open
the New Plate Dialog box.

6. Enter the information in Table 30.

Table 30. GeneMapper Plate Editor (1)

Protocol Editor Settings

Name e.g., Plate BT5 Date
Application Select GeneMapper Application
Plate type 96-Well

Owner Name/
Operator Name

7. Click “OK” and a new table in the Plate Editor opens automatically
(Table 31).

8. Click the column header to select the entire column. Select “Fill
Down” from the Edit menu to apply the information to all selected
samples. Click “OK”.

9. In the Run Scheduler, click “Find All”, and select “Link” to link the
reaction plate on the autosampler tray to the newly created plate
record (position A or B).
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Table 31. GeneMapper Plate Editor (Il)

Parameter Settings

Sample Name Enter the name for the samples

Priority e.g., 100 (Default)

Sample Type Sample or Allelic Ladder

Size Standard e.g., SST-BTO_60-500bp

Panel e.g., HDplex Panels

Analysis Method e.g., Analysis HID 3130

Snp Set -

User-defined 1-3 -

Results Group 1 (Select results group)

Instrument Protocol 1 Run36 POP4 BT5 26min (setting described
before)

10. Start the run.

11. During the run, view Error Status in the Event Log or examine the
quality of the raw data for each capillary in the Capillaries Viewer or
the Cap/Array Viewer.

12. View data as an overview in Run History or Cap/Array Viewer of the
Data Collection Software.

Run data are saved in the Run Folder of the previously chosen Result Group.
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Analysis parameters/analysis method

Table 32 lists the recommended analysis parameters.

Table 32. Recommended settings for the Applied Biosystems
3130/3130xI Genetic Analyzer

Parameter Settings

Peak Detection Algorithm Advanced

Ranges Analysis: Partial Range
Start Point: 2000; Stop Point: 10,000
Sizing: All Sizes

Smoothing and Baselining Smoothing: Light
Baseline Window: 51 pts

Size Calling Method Local Southern Method
Peak Detection Peak Amplitude Thresholds
B:* Y:*
G:* R:*
O:*

Min. Peak Half Width: 2 pts
Polynomial Degree: 3
Peak Window Size: 11 pts'
Slope Thresholds: 0.0

* The peak amplitude threshold (cutoff value) corresponds to the minimum peck height that
will be detected by the GeneMapper ID Software. The thresholds are usually 50-200 RFU
and should be determined individually by the laboratory. Recommendation: The minimall
peak height should be three-times higher than the background noise of the baseline.

t Only the setting for Peak Window Size is different to defaults from Applied Biosystems for
HID analysis.

Note: For information on the use of the recommended Template Files (as
analysis parameters), refer to the appropriate Investigator Template Files User
Guide (Genotyper, GeneMapper ID, or GeneMapper ID-X).
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Protocol: Electrophoresis Using the Applied
Biosystems 3500/3500xL Genetic Analyzer

For detailed instructions on instrument setup, spectral calibration, or application
of the Applied Biosystems 3500 Series Data Collection Software version 1.0 and
the GeneMapper ID-X Software version 1.2, refer to the Applied Biosystems
3500/3500xL Genetic Analyzers User Guide.

The system with 8 capillaries is the Applied Biosystems 3500 Genetic Analyzer
and the system with 24 capillaries is the Applied Biosystems 3500xL Genetic
Analyzer.

The virtual filter set AnyDye is used for combined application of the 5
fluorescent labels 6-FAM, BTG, BTY, BTR, and BTO. This matrix standard is
known as BT5.

The materials required for electrophoresis are given in Table 33.

Table 33. Materials required for electrophoresis

Material Specifications

Capillary 36 cm Array for Applied Biosystems 3500/3500xL
Genetic Analyzer

Polymer POP-4 for Applied Biosystems 3500/3500xL
Genetic Analyzer

Buffer Anode Buffer Container (ABC) 3500 Series
Cathode Buffer Container (CBC) 3500 Series

Spectral calibration/matrix generation

Before conducting DNA fragment size analysis, it is necessary to perform a spectral
calibration with the 5 fluorescent labels 6-FAM, BTG, BTY, BTR, and BTO for each
analyzer (Table 34). The calibration procedure creates a matrix which is used to
correct the overlapping of fluorescence emission spectra of the dyes.

IMPORTANT: Spectral calibration must be performed for each new capillary
array.

Spectral calibration is comprised of the following steps:
B Preparation of the instrument
Preparation of dye set BT5

Preparation of the standard calibration plate

Plate assembly and loading the plate in the instrument
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B Performing a spectral calibration run

B Checking the matrix

Preparation of the instrument

Before the spectral calibration process, ensure that the spatial calibration has

been performed. This process is described in detail in the Applied Biosystems
3500/3500xL Genetic Analyzers User Guide.

Preparation of dye set BT5

Prior to the spectral calibration, a dye set for the Matrix Standard BT5 must be
set up.

Table 34. The 5 fluorescent labels of BT5

Color Matrix standard
Blue (B) 6-FAM

Green (G) BTG

Yellow (Y) BTY

Red (R) BTR

Orange (O) BTO

1. To create a new dye set, go to “Library” and select “Analyze”,
followed by “Dye Sets” and click “Create”.

2. Enter a “Dye Set Name”, e.g., BT5.

3. Select “Matrix Standard” as a chemistry and “AnyDye Template” as a
dye set template.

4. Disable “Purple” in the field “Arrange Dyes”. Ensure that all other
colors are enabled.

5. Under “Calibration Peak Order” the colors need to be arranged as
follows: 5 - blue, 4 — green, 3 — yellow, 2 - red, and 1 - orange.

6. Do not alter the “Parameter” settings.
7. Click “Save” to confirm the changes.
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The parameters will be used for instruments configured with 36cm capillary array and polymer POP4
Matrix Condition Mumber Upper Limit - 20.0
Locate Start Paint * After Scan 300 * Before Scan 5000
* Limit Scans To 20000
Sensitivity 0.1
* Minimum Quality Score 0.5

Maotes

Matrix Std, BTS multi cap, -

Clase Save

Setup of dye set BT5.
Preparation of the standard calibration plate

Example for 8 capillaries (Applied Biosystems 3500 Genetic Analyzer)

8. Set up a mixture of formamide and Matrix Standard BT5 according to
Table 35.

Table 35. Setup of formamide and Matrix Standard BT5 mixture for
8 capillaries

Component Volume
Hi-Di Formamide 90 ul
Matrix Standard BT5 multi-cap. 10 ul
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9. Load 10 ul of the mixture to a 96-well plate, e.g., positions A1-H1.
10. Denature for 3 min at 95°C.
11. Snap freeze by placing the plate on ice for 3 min.

Alternatively, the thermal cycler set to 4°C may be used to cool the plate.

Example for 24 capillaries (Applied Biosystems 3500xL Genetic Analyzer)

1. Set up a mixture of formamide and Matrix Standard BT5 according to
Table 36.

Table 36. Setup of formamide and Matrix Standard BT5 mixture for
24 capillaries

Component Volume
Hi-Di Formamide 225 ul
Matrix Standard BT5 multi-cap. 25 ul

2. Load 10 ul of the mixture to a 96-well plate, e.g., positions A1-H1,
A2-H2, and A3-H3.

Denature for 3 min at 95°C.
4. Snap freeze by placing the plate on ice for 3 min.

w

Alternatively, the thermal cycler set to 4°C may be used to cool the plate.

Plate assembly and loading the plate in the instrument

The necessary steps are described in detail in the Applied Biosystems
3500/3500xL Genetic Analyzers User Guide.

Performing a spectral calibration run

Once the multiwell plates containing the spectral calibration mixture are placed
in the autosampler tray, the spectral calibration process can be started.

5. To access the Spectral Calibration screen, select “Maintenance” on
the Dashboard of the 3500 Series Data Collection software.

6. The number of wells in the spectral calibration plate and their
location in the instrument must be specified.

7. Select “Matrix Standard” as a chemistry standard and “BT5” for dye
set.

8. (Optional) Enable “Allow Borrowing”.
9. Click “Start Run”.
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Checking the matrix

Click a capillary in the table in order to display the results for each capillary
(spectral data, Quality value, and Condition Number) below the run results table.

B The quality value (Q value) of each capillary must be greater than 0.8 and
the number range (C value) must be between 1 and 20.

B Check the matrix samples for a flat baseline. As shown in the figure, there
should be 5 peaks with peak heights of about 1000-5000 RFU for each
matrix sample (Note: The optimal range is 2000-4000 RFU).

~ Intensity vs Scan Number

Calibrated Data + = BEEE

0 400 800 1200 1600 2000 2400 2800 3200

Intensity vs Scan Number

Electropherogram of spectral calibration of the matrix standard BT5 on an Applied
Biosystems 3500 Genetic Analyzer.

When a spectral calibration is successfully completed, the “Overall” row
displays green results. If the “Overall” row displays red results, refer to the

“spectral calibration troubleshooting” section of the Applied Biosystems
3500/3500xL Genetic Analyzers User Guide.
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Example of successful spectral calibration of the matrix standard BT5 for all capillaries
with an Applied Biosystems 3500 Genetic Analyzer.
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For each capillary, select and display the spectral and raw data. Check that the
data meet the following criteria:

B The order of the peaks in the spectral profile from left to right read orange-
red-yellow-green-blue

B No extraneous peaks appear in the raw data profile

B Peak morphology in the spectral profile shows no gross overlaps, dips, or
other irregularities. Separate and distinct peaks should be visible

If the data for all capillaries meet the criteria above, click “Accept Results”. If
any capillary data does not meet the criteria above, click “Reject Results”, and
refer to the “spectral calibration troubleshooting” section of the Applied
Biosystems 3500/3500xL Genetic Analyzers User Guide.

Sample preparation

1. Set up a mixture of formamide and DNA size standard according to
Table 37.

Table 37. Setup of formamide and DNA size standard mixture

Component Volume per sample
Hi-Di Formamide 12.0 ul
DNA Size Standard 550 (BTO) 0.5 ul

2. Aliquot 12 ul of the mixture to a tube for each sample to be
analyzed.

Add 1 pl PCR product or allelic ladder (diluted, if necessary).
Denature for 3 min at 95°C.

W

5. Snap freeze by placing the plate on ice for 3 min.
Alternatively, the thermal cycler set to 4°C may be used to cool the plate.

6. Load the samples on the tray.

Since injections take place simultaneously on all capillaries, 8 or 24 samples
must be pipetted onto the plate of multi-capillary analyzers. If fewer samples
are analyzed, the empty positions must be filled with 12 ul Hi-Di Formamide.
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To ensure a reliable allelic assignment on multi-capillary analyzers, inject one
allelic ladder for each set of 24 samples:

B 8-capillary instruments: One allelic ladder per 3 injections
B 24-capillary instruments: One allelic ladder per 1 injection

Room temperature may influence the performance of PCR products on multi-
capillary instruments, so that shoulder peaks or split peaks occur, especially at
low temperatures. Ensure ambient conditions are kept, as recommended by the
instrument manufacturer.

Setting up a run

If you are using the Investigator HDplex Kit for the first time on an Applied
Biosystems 3500 Genetic Analyzer, you will first need to set up a number of
protocols:

B Instrument Protocol
B Size Standard
B QC Protocol

B Assay

All protocols can be set up via the Dashboard of the 3500 Series Data
Collection software.

1. To set up the Instrument Protocol, go to “Library” and select
“Analyze”, followed by “Instrument Protocols” and click “Create”.
Note: Please modify the Run Module Default settings from “HID36_POP4”
as shown in Table 38.

2. The parameters in Table 38 must be entered or selected.
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Table 38. Instrument Protocol parameters for the Applied Biosystems

3500 Genetic Analyzer

Protocol Name

Oven Temperature (°C)
Run Voltage (kV)
PreRun Voltage (kV)
Injection Voltage (kV)
Run Time (s)

PreRun Time (s)
Injection Time (s)

Data Delay (s)
Advanced Options

Parameter Setting
Application Type HID
Capillary Length 36 cm
Polymer POP4

Dye Set e.g., BT5

Run Module HID36 POP4

e.g., Investigator HDplex
Default

Default

Default

3.0

1300*

Default

8.0f

Default

Default

* Deviating from the standard settings, the injection time may range between 1 and 20 s

depending on the type of sample. If samples with very high signal intensities are recorded, a
shorter injection time may be selected. For samples with low DNA content, an injection time

of up to 20 s may be necessary.

3. Click “Save” to confirm the changes.

4. To set up the Size Standard, go to “Library”, select “Analyze”,
followed by “Size Standards”, and click “Create”.
5. The parameters in Table 39 must be entered or selected.

The DNA Size Standard 550 (BTO) should be used with the following
lengths of fragments: 60, 80, 90, 100, 120, 140, 160, 180, 200, 220,

240, 250, 260, 280, 300, 320, 340, 360, 380, 400, 425, 450, 475, 500,

525, and 550 bp.
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Table 39. Size standard parameters

Parameter Setting
Size Standard e.g., SST-BTO_60-550
Dye Color Orange

6. Click “Save” to confirm the changes.

7. To set up the QC Protocol, go to “Library” and select “Analyze”,
followed by “QC Protocols”, and click “Create”.

8. The parameters in Table 40 must be entered or selected.

Table 40. QC Protocol parameters

Parameter Setting

Protocol Name e.g., BTO 550

Size Standard SST-BTO_60-550 (from step 4)
Sizecaller SizeCaller v1.1.0

9. Go to “Analysis Settings”, followed by “Peak Amplitude Threshold”
and disable “Purple”. Ensure that all other colors are enabled.

Check the recommended analysis settings in Table 43. All other settings
should remain as “Default”.
10. Click “Save” to confirm the changes.

11. To set up an Assay, go to “Library” and select “Manage”, followed
by “Assays”, and click “Create”.

12. To analyze Investigator HDplex fragments, the parameters in Table
41 must be selected.
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Table 41. Assay parameters

Parameter Setting

Assay Name e.g., Investigator HDplex

Color Default

Application Type HID

Instrument Protocol e.g., Investigator HDplex (from step 1)
QC Protocols e.g., BTO_550 (from step 7)

13. Click “Save” to confirm the changes.

Starting the run

1. In the Dashboard, click “Create New Plate”.

2. Go to “Define Plate Properties” and select “Plate Details”. Select or
enter the parameters in Table 42.

Table 42. Plate properties

Property Setting
Name e.g., Investigator HDplex
Number of Wells 96
Plate Type HID
Capillary Length 36 cm
Polymer POP4
3. Click “Assign Plate Contents” to confirm the changes.

4. Enter the designated sample name in each well containing a sample
or allelic ladder. This will identify the well positions of each sample
for the data collection and processing.
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5. Choose the correct Assay for the analysis. If you followed the steps
under “Setting up the Run”, this would be Investigator HDplex from
step 11. All named wells on the plate must have an assigned assay.

6. Select the wells for which to specify an assay. Check the box next to
the assay name to assign it to the selected wells.

7. (Optional) Repeat for file name conventions and results group.

8. If not already done, load the assembled plate to the instrument and
close the instrument door to re-initialize the instrument. Then, click

“Link Plate for Run”. In the next screen, enter the desired Run Name
and click “Start Run”.
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Analysis parameters/analysis method

Table 43 lists the recommended analysis parameters in the worksheet Peak
Detector.

Table 43. Recommended settings for the Applied Biosystems
3500/3500xL

Parameter Settings

Peak Detection Algorithm Advanced

Ranges Analysis: Partial Range
Start Point: 1000; Stop Point: 20,000
Sizing: All Sizes

Smoothing and Baselining Smoothing: Light
Baseline Window: 51 pts

Size Calling Method Local Southern Method
Peak Detection Peak Amplitude Thresholds
B:x Y:*
G:* R:*
O:*

Min. Peak Half Width: 2 pts
Polynomial Degree: 3
Peak Window Size: 11 pts'
Slope Thresholds: 0.0

* The peak amplitude threshold (cutoff value) corresponds to the minimum peak height that
will be detected by the GeneMapper ID-X Software version 1.2. The thresholds are usually
50-200 RFU and should be determined individually by the laboratory. Recommendation:
The minimal peak height should be three-times higher than the background noise of the
baseline.

T Only the setting for Peak Window Size is different to defaults from Applied Biosystems for
HID analysis.
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Protocol: Analysis

For general instructions on automatic sample analysis, refer to the appropriate
User and/or Workflow Guides for Investigator IDproof Software, Investigator
IDproof Mixture Software, GeneScan, GeneMapper ID, or GeneMapper ID-X
Software.

Note: The red panel should be faded out.

Finding the exact lengths of the amplified products depends on the device type,
the conditions of electrophoresis, as well as the DNA size standard used. Due to
the complexity of some loci, determining the size should be based on evenly
distributed references. The DNA Size Standard 550 (BTO) should be used with
the following lengths of fragments: 60, 80, 90, 100, 120, 140, 160, 180, 200,
220, 240, 250, 260, 280, 300, 320, 340, 360, 380, 400, 425, 450, 475,
500, 525, and 550 bp.
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Figure 1. Electropherogram of the DNA Size Standard 550 (BTO), fragments with
lengths in bp.

Analysis software

Allele allocation should be carried out with suitable analysis software, e.g.,
QIAGEN Investigator IDproof or IDproof Mixture Software, or Genotyper,
GeneMapper ID, or GeneMapper ID-X Software in combination with the
Investigator Template Files available as a download from www.giagen.com or

on a CD-ROM (cat. no. 389900), see Table 44 and Table 45.

The recommended Investigator Template File for Genotyper Software is the
HDplex.

I EEEE————————————————————————
50 Investigator HDplex Handbook 11/2012



Table 44. Recommended Investigator Template Files for GeneMapper ID

File type File name

Panels HDplex_Panels
BinSets HDplex Bins

Size standard SST-BTO_60-500bp
Analysis Method Analysis HID 310

Analysis HID_3130

Analysis HID _310_50rfu

Analysis HID 3130 50rfu
Plot Settings PlotsBT5 4dyes

Table Settings Table for 2 alleles
Table for 10 alleles

Panels and BinSets must always be used; other template files are optional.

Table 45. Recommended Investigator Template Files for GeneMapper ID-X

File type File name

Panels HDplex Panels x
BinSets HDplex Bins x
Stutter HDplex_Stutter x
Size standard SST-BTO_60-500bp
Analysis Method Analysis HID 310

Analysis HID 3130
Analysis HID 310 50rfu
Analysis_ HID 3130 _50rfu
Analysis_ HID 3500

Plot Settings PlotsBT5 4dyes

Table Settings 310 Data Analysis/31xx Data Analysis

Panels and BinSets must always be used; other template files are optional.
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Controls

The alleles listed in Table 46 represent the Control 9948 (included in the
Investigator HDplex Kit) and DNA from other commercially available standard
cell lines.

Table 46. Allele assignment of the Investigator HDplex Kit

Locus CCR CCR ATCC CCR
9948 9947A K-562 3657
Amelogenin X/Y X/X X/X XY
D251360 22/25 23/24 20/28 22/23
D3S1744 18/18 17/17 18/18 14/17
D452366 9/14 11/13 13/13 9/14
D552500 11/15 15/16 15/15 11/16
D6S474 16/16 13/17 14/17 15/16
D7S1517 20/22 19/25 21/24/25 24/25
D8S1132 20/24 19/21 20/24 17/18
D10S2325 8/14 9/10 7/13 9/14
D12S391 18/24 18/20 23/23 18/19
D18S51 15/18 15/19 15/16 12/20
D21S2055 19.1/26 19.1/26 28/35 19.1/25
SE33 23.2/26.2 19/29.2 26.2/28.2  22.2/27.2

For further confirmation, the table above displays the alleles of the reference DNA
purchased from Coriell Cell Repositories (CCR), as well as 3 reference DNAs
purchased from CCR and ATCC up to the standard of Szibor et al. (2003).
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Alleles

Table 47 shows the alleles of the allelic ladder. All analyses have been
performed using an Applied Biosystems 3500 Genetic Analyzer with POP-4
polymer (Figure 2 and Figure 3). Different analysis instruments, DNA size
standards, or polymers may result in different fragment lengths. In addition, a
visual alignment with the allelic ladder is recommended.

Scaling
B Horizontal: 70-480 bp
B Vertical: Depending on signal intensity
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Table 47. Allelic ladder fragments included in the Investigator HDplex
Kit

Locus Dye label Repeat numbers of allelic ladder

Amelogenin  6-FAM X, Y

D7S1517 6-FAM 16,17,18, 19, 20, 21, 22, 23, 24, 25, 26,
27,28

D3S1744 6-FAM 13,14,15,16,17,18, 19, 20, 21

D12S391 6-FAM 15,16,17,18,19, 20, 21, 22, 23, 24, 25,
26

D2S1360 6-FAM 19, 20, 21, 22, 23, 24, 26, 27, 28, 29, 30,
31, 32

D65S474 6-FAM 13,14,15,16,17,18, 19

D4S52366 6-FAM 9,10,11,11.2,12,13, 14,15

D8S1132 BTG 12.1,13.1,14.1, 15,16, 17,18, 19, 20, 21,
22,23, 24, 25, 26, 27

D552500 BTG 9,10,11,12,13,14,15,16,17, 18

D18S51 BTG 8,9,10,10.2,11,12,13, 14,15, 16, 17,

17.2,18,18.2, 19, 20, 21, 21.2, 22, 23, 24,
25, 26,27, 28

D2152055 BTG 16.1,17.1,18.1,19.1, 20.1, 21.1, 22.1, 23,
24,25, 26,27, 28, 29, 30, 31, 32, 33, 34,
35, 36, 37, 39

D10S2325 BTY 6,7,8,9,10,11,11.2,12,13, 14,15, 17,
19

SE33 BTY 6.3,7.3,8,9,10,10.2,11,12,13, 13.2,

14,15,15.2,16*,17,18,18.2, 19, 19.2,
20, 20.2, 21, 21.2,22.2, 23.2, 24.2, 25,
25.2,26.2,27.2*%,28.2,29.2, 30.2,31.2,
32, 32.2, 33, 33.2, 34, 34.2, 35, 35.2, 36,
36.2, 37, 38, 49
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Figure 2. Electropherogram of the Investigator HDplex Kit using 500 pg Control DNA
9948. Analysis was performed on an Applied Biosystems 3500 Genetic Analyzer. Allele
assignment was performed using Investigator IDproof Software.
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Figure 3. Electropherogram of the allelic ladder HDplex analyzed on an Applied
Biosystems 3500 Genetic Analyzer. Allele assignment was performed using Investigator
IDproof Software.
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Interpretation of Results

Post-PCR analysis and automatic allele assignment with suitable analysis
software ensure a precise and reliable discrimination of alleles.

General procedure for the analysis
1. Check the DNA size standard.

2. Check the dallelic ladder.

3. Check the positive control.

4. Check the negative control.

5. Analyze and interpret the sample data.
Pull-up peaks

Pull-up peaks may occur if peak heights are outside the linear detection range
(see “Troubleshooting Guide”, page 57), or if an incorrect matrix was applied.
They appear at positions of specific peaks in other color channels, typically with
lower signal intensities. Peak heights should not exceed 3000 RFU in order to
prevent pull-up peaks.

Stutter peaks

The occurrence of stutter peaks depends on the sequence of the repeat structure
and the number of alleles. n —4 peaks are caused by a loss of a repeat unit
during amplification of tetranucleotide STR motifs, caused by slippage effects of
the Tag DNA Polymerase. These peaks should be interpreted using the
Investigator Template Files for Genotyper, GeneMapper ID, and GeneMapper
ID-X Software.

Template-independent addition of nucleotides

Because of its terminal transferase activity, the Tag DNA Polymerase may cause
incomplete adenylation at the 3'-end of the amplified DNA fragments. The
artifact peak is one base shorter than expected (-1 peaks). All primers included
in the Investigator HDplex Kit are designed to minimize these artifacts. Artifact
formation is further reduced by the final extension step of the PCR protocol at
68°C for 60 minutes. Peak height of the artifact correlates with the amount of
DNA. Laboratories should define their own limits for analysis of the peaks.

Artifacts

Room temperature may influence the performance of PCR products on multi-
capillary instruments, so that shoulder peaks or split peaks occur. If shoulder or
split peaks appear, we recommend injecting the sample again.
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Troubleshooting Guide

This troubleshooting guide may be helpful in solving any problems that may
arise. For more information, see also the Frequently Asked Questions page at
our Technical Support Center: www.giagen.com/FAQ/FAQList.aspx. The
scientists in QIAGEN Technical Services are always happy to answer any
guestions you may have about either the information and protocols in this
handbook or sample and assay technologies (for contact information, see back
cover or visit www.giagen.com).

Comments and suggestions

Sample preparation

Sample signal intensity  Reduce the volume of the DNA Size Standard
must be increased 550 (BTO) to peak heights of about 500 RFU.

Purify the PCR products before starting the
analysis. We recommend the MinElute® PCR
Purification Kit for rapid and effective purification
(see Ordering Information).

Matrix/spectral calibration is not appropriate

There are pull-up This matrix cannot be used for the analysis.
peaks between the dye  Repeat the matrix generation/spectral

panels (B, G, Y, R, O) calibration. Be sure to carefully follow the correct
with the current matrix/  protocol for the specific analysis instrument.
spectral calibration

Many peaks are labeled as off-ladder (OL) alleles in the samples

a) DNA Size Standard Click the orange “Size Match Editor” icon in the
550 (BTO) was not upper toolbar or the GeneMapper ID or ID-X
defined or identified Software. Mark orange fragments of all samples.
correctly Always use the DNA Size Standard 550 included

in Investigator Human Identification PCR Kits.
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Comments and suggestions

b) Signal intensities are Reduce the injection time in increments to a
too high. If the peak minimum of 1 s, reduce the amount of the PCR
heights of the samples  amplification product for analysis, or reduce the
are outside the linear quantity of DNA for PCR.
detection range
(>4000 RFU/>5000
RFU*), stutters, split
peaks, and artifacts
may be increased

c) Bubbles in the capillary Repeat electrophoresis to confirm results.
lead to pull-up peaks
in all color panels
(“spikes”) that result in
allele misnomer

d) Differences in the run For reliable allelic assignment on multi-capillary
performance among analyzers, a number of allelic ladders should be
the capillaries of a run.
multi-capillary analyzer
may result in allelic
assignment shift

e) Use of 32-cycle PCR Too small amounts of DNA may result in allelic
program for small dropouts and imbalances of the peaks.
amounts of DNA Furthermore, nonspecific amplification products

may appear. By increasing the number of cycles,
there is a risk of cross-contamination due to
impurities.

Injection/file of the allelic ladder is not appropriate

a) An additional signal Use a different injection/file of the allelic ladder
can be identified as and check the data of the analyzed sizes from
peak of the allelic the Size Standard (in bp) of the allelic ladder.
ladder because of Always use the DNA Size Standard 550 for

dysfunctions during the
electrophoresis. If
peaks of the allelic
ladder are miscalled,
the ladder cannot be
used for the analysis

Investigator Human Identification PCR Kits.

* >4000 RFU for the ABI PRISM 310 Genetic Analyzer; >5000 RFU for the ABI PRISM 3100
and Applied Biosystems 3130/3500 Genetic Analyzers.
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Comments and suggestions

b) One peak of the allelic  The allelic ladder must be loaded onto the
ladder is below the analysis instrument at a higher concentration
peak detection value than samples to be analyzed.

(50-200 RFU) of the
analysis method used,
and thus, is not

identified

Alternatively, allelic ladder data can be analyzed
with a lower peak detection value in Analysis
Software.

c) One peak of the allelic  Compare the length of the fragments (in bp) of
ladder is not identified  the first allele in one color of the allelic ladder
because it is outside with the corresponding value in the categories.
the expected size range Then compare it with the other alleles.
of the software (in bp)

d) Point alleles are not Point alleles are i.e., alleles with at least T bp
found difference to the next integer allele. Check the
settings of the analysis method. Lower the Peak
Window Size value to 11 points.

I EEEE————————————————————————
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References

QIAGEN maintains a large, up-to-date online database of scientific
publications utilizing QIAGEN products. Comprehensive search options allow
you to find the articles you need, either by a simple keyword search or by
specifying the application, research areaq, title, etc.

For a complete list of references, visit the QIAGEN Reference Database online
at www.qgiagen.com/RefDB/search.asp or contact QIAGEN Technical Services
or your local distributor.
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Ordering Information

Product Contents Cat. no.
Investigator HDplex  Primer mix, reaction mix, DNA Polymerase, 381213
Kit (25) Control DNA, allelic ladder, DNA size

standard, and nuclease-free water
Investigator HDplex  Primer mix, reaction mix, DNA Polymerase, 381215
Kit (100) Control DNA, allelic ladder, DNA size

standard, and nuclease-free water
Related products
Investigator Human Identification PCR Kits
Investigator ESSplex  Primer mix, Fast Reaction Mix including 381535
Plus Kit (100)* HotStarTag® Plus DNA Polymerase, Control

DNA, dllelic ladder ESSplex Plus, DNA size

standard 550 (BTO), and nuclease-free water
Investigator ESSplex  Primer mix, Fast Reaction Mix including 381545
SE Plus Kit (100)* HotStarTaq Plus DNA Polymerase, Control

DNA, allelic ladder ESSplex SE Plus, DNA size

standard 550 (BTO), and nuclease-free water
Investigator IDplex ~ Primer mix, Fast Reaction Mix including 381625
Plus Kit (100)* HotStarTaq Plus DNA Polymerase, Control

DNA, dllelic ladder IDplex Plus, DNA size

standard 550 (BTO), and nuclease-free water
Investigator Primer mix, reaction mix, DNA Polymerase, 381315
Nonaplex ESS Kit Control DNA, allelic ladder, DNA size
(100)* standard, and nuclease-free water
Investigator Triplex  Primer mix, reaction mix, DNA Polymerase, 380315
AFS QS Kit (100)* Control DNA, allelic ladder, DNA size

standard, and nuclease-free water
Investigator Triplex  Primer mix, reaction mix, DNA Polymerase, 380325
DSF Kit (100)* Control DNA, allelic ladder, DNA size

standard, and nuclease-free water
Investigator Argus Primer mix, reaction mix, DNA Polymerase, 383615
Y-12 QS Kit (100)*  Control DNA, allelic ladder, DNA size

standard, and nuclease-free water
* Larger kit sizes available; please inquire.
Investigator HDplex Handbook 11/2012 61



Product Contents Cat. no.

Investigator Argus Primer mix, reaction mix, DNA Polymerase, 383213
X-12 Kit (25)* Control DNA, allelic ladder, DNA size

standard, and nuclease-free water
Investigator DIPplex  Primer mix, reaction mix, DNA Polymerase, 384013
Kit (25)* Control DNA, allelic ladder, DNA size

standard, and nuclease-free water
Investigator Quantification Kits

Investigator Primer mix IC FQ, reaction mix FQ, control 387016
Quantiplex Kit (200) DNA Z1, dilution buffer

Investigator Primer mix IC YQ, reaction mix FQ, Control = 387116
Quantiplex HYres Kit  DNA Z1, dilution buffer

Investigator Human Identification PCR Kit Accessories

Matrix Standard BT5 Matrix standard 6-FAM, BTG, BTY, BTR, 386113
single cap. (5 x25) and BTO
Matrix Standard BT5 Matrix standard 6-FAM, BTG, BTY, BTR, 386123
multi cap. (25) and BTO
Matrix Standard BT5 Matrix standard 6-FAM, BTG, BTY, BTR, 386125
multi cap. (50) and BTO
Multi Tag2 DNA 100 Units Multi Tag2 DNA Polymerase 386315

Polymerase (100)
Analysis software

Investigator IDproof ~ Software package on CD including 9020775
Software installation files for the Desktop, Server and
Client versions of IDproof Software

Investigator IDproof ~ Free use of the IDproof Desktop version of 389001

Demo Key the software for 30 days after installation
Investigator IDproof  Allows the unlimited use of the Desktop 389002
Single Key version of the software; to be installed on a

single workstation with a local database

* Larger kit sizes available; please inquire.
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Product

Contents

Cat. no.

Investigator IDproof
Server Key

Investigator IDproof
Client Key

Investigator IDproof
Mixture Software

Investigator IDproof
Mixture Demo Key

Investigator IDproof
Mixture Single Key

Investigator IDproof
Mixture Server Key

Investigator IDproof
Mixture Client Key

Investigator
Template Files

Allows for setup of a server that maintains
the database and various workstations to
access that database. Must be purchased in
conjunction with the Client Key

Must be purchased in conjunction with the
Server Key

Software package on CD including
installation files for the Desktop, Server and
Client versions of IDproof Mixture Software

Free use of the IDproof Mixture Desktop
version of the software for 30 days after
installation

Allows the unlimited use of the Desktop
version of the software; to be installed on a
single workstation with a local database

Allows for setup of a server that maintains
the database and various workstations to
access that database. Must be purchased in
conjunction with the Client Key

Must be purchased in conjunction with the
Server Key

All template files for Investigator Human
Identification PCR Kits for use with
GeneMapper ID, GeneMapper ID-X, and
Genotyper Software, as well as DIPSorter
freeware (CD-ROM)
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389004

9020777

389401

389402

389403

389404

389900
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Product Contents Cat. no.

DNA extraction and purification

QlAamp® DNA 50 QlAamp MinElute Columns, Proteinase K, 56504
Investigator Kit (50)  Carrier RNA, Buffers, Collection Tubes (2 ml)

EZ1® DNA Reagent Cartridges (DNA Investigator), 952034
Investigator Kit (48)  Disposable Filter-Tips, Disposable Tip-

Holders, Sample Tubes (2 ml), Elution

Tubes (1.5 ml), Buffer G2, Proteinase K,

Carrier RNA

MinElute PCR 50 MinElute Spin Columns, Buffers, 28004
Purification Kit (50)* Collection Tubes (2 ml)

For up-to-date licensing information and product-specific disclaimers, see the
respective QIAGEN kit handbook or user manual. QIAGEN kit handbooks and
user manuals are available at www.giagen.com or can be requested from
QIAGEN Technical Services or your local distributor.

* Larger kit sizes available; please inquire.
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Trademarks: QIAGEN®, QlAamp®, EZ17, HotStarTaq®, Investigator®, MinElute® (QIAGEN Group); 3500™, ABI PRISM®, Applied Biosystems®,
Avant™, GeneAmp®, GeneMapper®, GeneScan®, Genotyper®, 6-FAM™, POP-4™, Hi-Di™ (Applera Corporation or its subsidiaries); Eppendorf®,
Mastercycler® (Eppendorf AG); GenBank ® (US Department of Health and Human Services). Registered names, trademarks, etc. used in this
document, even when not specifically marked as such, are not to be considered unprotected by law.

Limited License Agreement for the Investigator HDplex Kit

Use of this product signifies the agreement of any purchaser or user of the product to the following terms:

1.

o > LN

The product may be used solely in accordance with the protocols provided with the product and this handbook and for use with components
contained in the kit only. QIAGEN grants no license under any of its intellectual property to use or incorporate the enclosed components of this
kit with any components not included within this kit except as described in the protocols provided with the product, this handbook, and
additional protocols available at www.giagen.com. Some of these additional protocols have been provided by QIAGEN users for QIAGEN
users. These protocols have not been thoroughly tested or optimized by QIAGEN. QIAGEN neither guarantees them nor warrants that they do
not infringe the rights of third-parties.

Other than expressly stated licenses, QIAGEN makes no warranty that this kit and/or its use(s) do not infringe the rights of third-parties.
This kit and its components are licensed for one-time use and may not be reused, refurbished, or resold.
QIAGEN specifically disclaims any other licenses, expressed or implied other than those expressly stated.

The purchaser and user of the kit agree not to take or permit anyone else to take any steps that could lead to or facilitate any acts prohibited

above. QIAGEN may enforce the prohibitions of this Limited License Agreement in any Court, and shall recover all its investigative and Court
costs, including attorney fees, in any action to enforce this Limited License Agreement or any of its intellectual property rights relating to the kit
and/or its components.

For updated license terms, see www.giagen.com.
© 2010-2012 QIAGEN, all rights reserved.



www.giagen.com

Australia = techservice-au@qiagen.com
Austria = techservice-at@giagen.com
Belgium = techservice-bnl@giagen.com
Brazil = suportetecnico.brasil@qiagen.com
Canada = techservice-ca@giagen.com
China = techservice-cn@giagen.com
Denmark = techservice-nordic@qiagen.com
Finland = techservice-nordic@qgiagen.com
France = techservice-fr@qiagen.com
Germany = techservice-de@qiagen.com
Hong Kong = techservice-hk@qiagen.com
India = techservice-india@giagen.com
Ireland = techservice-uk@giagen.com

Italy = techservice-it@giagen.com

Japan = techservice-jp@giagen.com

Korea (South) = techservice-kr@qiagen.com
Luxembourg = techservice-bnl@giagen.com
Mexico = techservice-mx@giagen.com

The Netherlands = techservice-bnl@giagen.com
Norway = techservice-nordic@giagen.com
Singapore = techservice-sg@giagen.com
Sweden = techservice-nordic@qiagen.com
Switzerland = techservice-ch@giagen.com
UK = techservice-uk@giagen.com

USA = techservice-us@giagen.com
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